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Preface

Disclaimer of Warranty
AgilePoint, Inc. makes no representations or warranties, either express or implied, by or with respect to anything
in this document, and shall not be liable for any implied warranties of merchantability or fitness for a particular
purpose or for any indirect, special or consequential damages.

Copyright
Copyright © 2013 AgilePoint, Inc. All rights reserved.

Trademarks
AgilePoint, Inc. and AgilePoint's products are trademarks of AgilePoint Inc. References to other companies and
their products use trademarks owned by the respective companies and are for reference purpose only.

Government Rights Legend
Use, duplication or disclosure by the U.S. Government is subject to restrictions set forth in the applicable license
agreement and as provided in DFARS 227.7202-1(a) and 227.7202-3(a) (1995), DFARS 252.227-7013(c)(1)(ii)
(Oct 1988), FAR 12.212(a) (1995), FAR 52.227-19, or FAR 52.227-14, as applicable.

Virus-free software policy
AgilePoint recognizes that viruses are a significant security consideration for our customers. To date, we have
had no report of AgilePoint BPMS carries any virus. AgilePoint takes the following measures to ensure our
software is free of viruses upon delivery:

• AgilePoint is built on top of Microsoft .NET framework. The pre-compiled executable is a.NET Common
Language Runtime (CLR) application, not a native machine binary. As far as is known at this time, there are
no viruses that infect .NET CLR executables.

• The virtual environment for the product packaging process in is fully isolated and protected, and anti-virus
software is installed and running during packaging.

• The deliverable package is scanned by anti-virus software before upload to our customer download site.

Document Revision Numbers
AgilePoint documentation uses the revision number format rX.Y.Z. The letters and numbers in this revision
number can be interpreted as follows:
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• r - Indicates "revision." This helps to differentiate the document version numbers, which start with v.

• X - The major version number for AgilePoint BPMS to which this document refers. For example, AgilePoint
releases 5.0, 5.0 SP1, and 5.5 would all have an X value of 5.

• Y - The major document revision number. This number typically changes only when either there is a new
AgilePoint release, or there are major changes to the document.

• Z - The minor document revision number. This number is incremented each time the document is
republished.

AgilePoint Documentation in PDF and HTML
AgilePoint documentation is provided in both print-friendly (PDF) and web-based (HTML) formats.

Advantages of HTML Documentation

• HTML is the primary delivery format for AgilePoint documentation.

• Unified, global search across all documentation. PDF documents allow you to search only within the context
of a given PDF file.

• All hyperlinks supported. Links in PDFs are only supported in certain contexts.

• "One-stop shopping" for all information related to AgilePoint BPMS.

• The HTML documentation is updated more frequently than the PDF documentation. Web-based
documentation is updated periodically between AgilePoint releases to address errors and omissions, but the
PDF documentation is updated only at the time of a software release.

Advantages of PDF Documentation

PDFs can be more easily printed, archived, and transferred (such as by FTP or email) than HTML
documentation.

For more information, see Downloading Files and Sharing Links from the Documentation Library in the
Documentation Library.

Opening the Documentation Library
To open the AgilePoint Documentation Library, do the following.

Prerequisites

You must have a valid account on the AgilePoint Support Portal.

Instructions

1. Log on to the AgilePoint Support Portal.

2. Click Documentation.

3. On the Documentation page, click the documentation library for your AgilePoint release.

• For AgilePoint BPMS v5.0 SP1 and higher, the web-based documentation library opens in a new tab or
window in your web browser.

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
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• For releases prior to v5.0 SP1, a download starts for a Zip file with the PDF documentation for your
release.

Finding Information in the Documentation Library
The information in this topic will help you to locate information in the AgilePoint Documentation Library.

Using the Table of Contents

The table of contents in the AgilePoint Documentation Library is divided by content areas. For example, the
Installation section includes all the information you need to install AgilePoint BPMS. The AgilePoint API section
includes information about the AgilePoint APIs.

You can use the Table of Contents to explore the AgilePoint documentation content and find the information you
want.

Searching

The web-based documentation includes a centralized search for all documentation content. To search for
information:

1. In the AgilePoint Documentation Library, click the Search tab. In the Search box, enter 1 search team, and
click Search.

The search results display in alphabetical order by topic title.

It is important to understand that the third-party software AgilePoint uses to generate web-based
documentation allows only 1 search term. More than 1 search term will cause the search to fail.

AgilePoint recommends using a relatively unique search term to find the information you need. For example,
entering a common term, such as "process," will return a high percentage of the total documentation topics
in the search results.

2. Browse the list of topic titles to find the information you want.

Printing

The PDF documentation is provided mainly for the purpose of printing and archiving. To print a set of
information:

1. Navigate to the main page of the Documentation Library from which you want to print.

2. In the list of documents, click the document name in the PDF column.

3. From your PDF reader software, print the portion of the document you want.

Downloading Files and Sharing Links from the
Documentation Library
You can download and share files AgilePoint's documentation library as you would in any other web page. Note
that if you send links to recipients, they must have a Support Portal login to view the file.

These procedures are common examples based on Internet Explorer with the Adobe Reader plug-in. Exact
procedures may vary depending on your web browser, PDF viewer, and email client configuration.



Preface 8

AgilePoint BPMS v5.0 R2 SP1 Enterprise Manager Administrator's Guide r5.4.15

Share a Link to an HTML Topic

1. Navigate to the topic you want to share.

2. Copy the URL in the Location box in your web browser.

3. Paste the URL in an email, IM client, etc.

Share a Link to a PDF Document

1. In Internet Explorer, navigate to the Documentation Library home page.

2. In the PDF column, right-click the name of the PDF file you want to share.

3. In the quick menu, click Copy shortcut.

4. Paste the URL in an email, IM client, etc.

Save a Copy of a PDF Document

1. In Internet Explorer, open the Documentation Library home page.

2. In the PDF column, click the name of the PDF file you want to share.

3. In the Adobe Reader plug-in, click Save button.

Contacting AgilePoint Sales
AgilePoint is a leading Business Process Management System (BPMS) provider created by a team of driven
people who strive to incorporate the principles of relentless innovation for the benefit of our customers. Our
mission is to help companies of any size attain and sustain operational success through process excellence.

Headquarters: AgilePoint Corporation 1916C Old Middlefield Way Mountain View, CA 94043, USA

Tel: (650) 968 - 6789

Fax: (650) 968 - 6785

Email: info@agilepoint.com

Web site: www.agilepoint.com

International: For AgilePoint EMEA and AgilePoint Asia Pacific, please call the AgilePoint Corporate Office for
contact information.

  

Contacting Customer Support
To contact AgilePoint Support, please submit a ticket on the AgilePoint Support Portal: http://
support.agilepoint.com/SupportPortal/

If you do not have a Support Portal account, you can send an email to request one: support@agilepoint.com

mailto:info@agilepoint.com
http://www.agilepoint.com
http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
mailto:support@agilepoint.com
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AgilePoint Enterprise Manager
AgilePoint Enterprise Manager is an ASP.NET application that provides a web-based interface for power
users or system administrators to manage, monitor, and audit AgilePoint BPMS and its runtime activities and
processes.
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Getting Started
The information in this section provides a brief overview for getting started with the application.

Open Enterprise Manager
To open AgilePoint Enterprise Manager, do the following.

Instructions

1. Click Start > All Programs > AgilePoint > Enterprise Manager.

2. On the AgilePoint Enterprise Manager logon page, enter your user name and password.

This may be a user name and password specific to AgilePoint, or it may be the same as your Windows
account. This is determined by your AgilePoint administrator.

Localization for Enterprise Manager
AgilePoint Enterprise Manager provides localization support for English, Japanese, Chinese, Hebrew, Spanish,
and French. Once the localization feature is activated, a drop-down list becomes visible on the Main Page to
select the language for which to show. In order to expose this functionality, add the following 'add key' entry into
the web.config file for Enterprise Manager.

<configuration>
  <appSettings>
    <add key="SupportedLocale" value="en-US;ja-JP;zh-CN;he;es;fr" />
      </appSettings>
</configuration>
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After adding this configuration, the AgilePoint Enterprise Manager Main Page should look like the following:
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System
The System section of the Enterprise Manager Main Page allows the administrator to perform certain functions
such as view event processing performance and process information, set AgilePoint system and database
configurations, manage shared custom attributes, event services, and global email templates.

Create a Shared Custom Attribute
To create a shared custom attribute, do the following.

Navigation

1. On the Enterprise Manager Main Page, click Shared Custom Attributes.

2. On the Custom Attributes window, click Add.

Note:  This page can only be used by administrators and users with the Modify Shared Custom
Attributes access right.

Instructions

1. Complete the fields on the Custom Attributes Window.

Field Name Definition

Name Definition:

Specifies the reference name of the custom
attribute.

Allowed Values:

A text string that can contain spaces.

Default Value:

None

Type Definition:

Determines the data type for the shared custom
attribute.

Allowed Values:

• String

• Int32

• DateTime

• Decimal

• Boolean
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Field Name Definition

Default Value:

String

Value Definition:

The value that is applied to the shared custom
attribute at runtime.

Allowed Values:

A number or a text string that can contain spaces.

Default Value:

None

Update a Shared Custom Attribute
You can modify a shared custom attribute at runtime either manually using AgilePoint Enterprise Manager or
programmatically using the Managed Code C# Snippet.

To update a shared custom attribute using Enterprise Manager, do the following.

Navigation

1. On the Enterprise Manager Main Page, click Shared Custom Attributes.

2. On the Custom Attributes window, select the shared custom attribute you want to modify.

3. Click Edit.

Note:  This page can only be used by administrators and users with the Modify Shared Custom
Attributes access right.

Instructions

1. On the Custom Attributes window, edit the fields as required.

Field Name Definition

Name Definition:

Specifies the shared custom attribute you want to
update.

Allowed Values:

Read only.

Type Definition:

Determines the data type for the shared custom
attribute.
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Field Name Definition

Allowed Values:

• String

• Int32

• DateTime

• Decimal

• Boolean

Default Value:

String

Value Definition:

The value that is applied to the shared custom
attribute at runtime.

Allowed Values:

A number or a text string that can contain spaces.

Default Value:

None

To update a shared custom attribute programmatically using the Managed Code C# Snippet, do the following:

For example, you have defined a shared custom process attribute called "Something" in Enterprise
Manager. You set the value of the shared custom process attribute in Enterprise Manager. You now
want to use a Managed Code C# Snippet to dynamically change the value of the shared custom process
attribute "Something". 

The following is the syntax to update the value of the shared custom  process attribute "Something".
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Pages
This section provides a description of the pages in the System section of Enterprise Manager.

Shared Custom Attributes Page
This page allows the administrator to view and configure shared custom process attributes that can be accessed
from all processes running on the server (regardless of which process template the process is associated with).
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Custom Attributes Window
Creates a new shared custom attribute.

A shared custom attribute is a user defined attribute that can be used or shared across different processes
or environments using Enterprise Manager. For example, you can use the same custom attribute in various
environments: development, test, and production.

Navigation

1. On the Enterprise Manager Main Page, click Shared Custom Attributes.
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2. On the Custom Attributes window, click Add.

Note:  This page can only be used by administrators and users with the Modify Shared Custom
Attributes access right.

Field Definitions

Field Name Definition

Name Definition:

Specifies the reference name of the custom
attribute.

Allowed Values:

A text string that can contain spaces.

Default Value:

None

Type Definition:

Determines the data type for the shared custom
attribute.

Allowed Values:

• String

• Int32

• DateTime

• Decimal

• Boolean

Default Value:

String

Value Definition:

The value that is applied to the shared custom
attribute at runtime.

Allowed Values:

A number or a text string that can contain spaces.

Default Value:

None
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Add/Edit Shared Custom Attribute Page
The value of a shared custom process attribute can be modified at run time either manually via AgilePoint
Enterprise Manager or programmatically via the Managed Code C# Snippet.

To modify the value of a shared custom process attribute via Enterprise Manager:

Note:  This page can only be used by administrators and users with the Modify Shared Custom
Attributes access right.

This page allows the administrator add or edit a specific shared custom process attribute.

To modify the value of a shared custom process attribute programmatically via the Managed Code C# Snippet:

For example, you have defined a shared custom process attribute  called "Something" in Enterprise
Manager. You set the value of the shared custom process attribute in Enterprise Manager. You now
want to use a Managed Code C# Snippet to dynamically change the value of the shared custom process
attribute "Something".  Below is the syntax to update the value of the shared custom  process attribute
"Something"?
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Import Shared Custom Attributes Page
In Enterprise Manager, click Custom Attributes > Import to modify the system's current Shared Custom
Attributes by uploading an XML file containing the new values. For an example of a valid XML file, use the
Export Shared Custom Attributes page.

Export Shared Custom Attributes Page
In Enterprise Manager, click Custom Attributes > Export to download a ZIP-compressed XML file containing the
system's current Shared Custom Attributes.

Event Service Page
This page allows the administrator to initiate processes automatically via scheduling, email, database, or file
dropping. All event listeners can be configured via AgilePoint Enterprise Manager.

Note:  The Event Service AgileConnector must be added via the AgilePoint Server Configuration utility
before using the Event Service.
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Database Insert Configuration Window
Sets up the database insert event to trigger a process.

Prerequisites

• Only Microsoft SQL Server is supported at this time.

• As a best practice it is recommended to use a separate database table that is used for the Database Update
monitoring, this is because once the new database update process is triggered, the new database table row
and records will be deleted.

Navigation

1. On the Enterprise Manager Main Page, click Events Service.

2. On the Event Service page, click Database Insert > Add.
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Field Definitions

Field Name Definition

Description Definition:

A free text description of the event.

Allowed Values:

Multiple lines of text.

Default Value:

None.

Custom Attributes:

No

Connection String Definition:

Specifies the database connection string to be used
to connect to the database at runtime.

Allowed Values:

Multiple lines of text.

Default Value:

None

Custom Attributes:

No

Choose Opens the Following Window:

Browse Shared Custom Attributes

Purpose of this Window:

Enables you to choose a connection string from the
list of global custom attributes in the in the format of
a database connection string. Select the connection
string you want, and click OK.

Build Connection String Opens the Following Window:

Connection String Builder Window

Purpose of this Window:

Creates a connection string to connect AgilePoint
Event Services and a database.

Table Name Definition:
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Field Name Definition

Specifies the name of the database table you want.

Allowed Values:

The name of your table.

If you select the Enter Table Name check box, the
Table Name list becomes unavailable to select a
table name. Type a table name in the box.

Default Value:

None

Enter Table Name Definition:

Specifies that you want to enter a custom database
table name in the Table Name field.

Allowed Values:

• Deselected - The Table Name field is not
editable.

• Selected - The Table Name field allows a
custom table name to be entered.

Default Value:

Deselected

Primary Key Definition:

Specifies the primary key for the database table.

Allowed Values:

The name of your primary key.

If you select the Enter primary key check box, the
Primary Key list becomes unavailable to select a
primary key. Type a primary key in the box.

Default Value:

None

Enter Primary Key Definition:

Allows to type a primary key in the Primary Key box.

Allowed Values:

• Deselected - Specifies to select a primary key
from the Primary Key list.

• Selected - Specifies to type a primary key in the
Primary Key box.

Default Value:
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Field Name Definition

Deselected

Query Frequency Definition:

Specifies the query frequency in minutes.

Allowed Values:

An integer.

Default Value:

None

Custom Attributes:

No

Field Name Definition:

Specifies the database column name you want.

Allowed Values:

The name of your database column name.

Default Value:

None

Custom Attributes:

No

Data Bind Definition:

Specifies a custom attribute as a data field to be
assigned to the database column's data.

Allowed Values:

A custom attribute.

Default Value:

None

Add Function:

Assigns the specified custom attribute to the
database column's data and displays the values in a
tabular format.

Process Template Definition:

Specifies the name of the process model to be
triggered to create a process instance when
database insert event occurs.
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Field Name Definition

Allowed Values:

The name of your process model.

Default Value:

None

Default Process Instance Prefix Definition:

Specifies the prefix to be added to the process
instance name that is created when database insert
event occurs.

Allowed Values:

A text string.

If you select the Select Column Data check box,
a list is available to select a data column. The
selected data column's value is added as a prefix to
the process instance name.

Default Value:

None

Custom Attributes:

No

Select Column Data Definition:

Specifies that you want to use the data column's
value of the newly inserted record as a process
instance prefix.

Allowed Values:

• Deselected - The Default Process Instance
Prefix field is editable. Enter the text you want
to be added as a prefix to the process instance
name.

• Selected - The Default Process Instance
Prefix field allows to select a data column. The
selected data column's value is added as a
prefix to the process instance name.

Default Value:

Deselected

Enable this schedule Definition:

Determines whether the database insert trigger is to
be activated.

Allowed Values:
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Field Name Definition

• Deselected - Deactivates the database insert
trigger.

• Selected - Activates the database insert trigger.

Default Value:

Deselected

Connection String Builder Window
Creates a connection string to connect AgilePoint Event Services and a database.

Navigation

1. On the Enterprise Manager Main Page, click Events Service.

2. On the Event Service page, click Database Insert > Add.

3. On the Database Insert Configuration window, click Build Connection String.

Field Definitions

Field Name Definition

Data Source Definition:

Specifies the database server name, where SQL
Server has been installed.

Allowed Values:
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Field Name Definition

A valid database server name.

Default Value:

None.

Custom Attributes:

No

Example:

Demo3

Port Definition:

Specifies the port number to connect to the
database server.

Allowed Values:

A valid port number.

Default Value:

None.

Custom Attributes:

No

Integrated Security Definition:

Determines whether the SSPI integrated security is
to be activated.

Allowed Values:

• Deselected - Specifies not to activate the SSPI
integrated security.

• Selected - Specifies to activate the SSPI
integrated security.

Default Value:

Deselected

User ID Definition:

Specifies the user name for database
authentication.

Allowed Values:

A valid user name.

Default Value:

None
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Field Name Definition

Custom Attributes:

No

Password Definition:

The password for the authentication account.

Allowed Values:

A valid password.

Default Value:

None

Custom Attributes:

No

Retrieve Database Function:

Retrieves the names of existing databases from the
data source.

Database Name Definition:

Specifies the name of the database you want.

Allowed Values:

The name of your database.

If you select the Enter Database Name check box,
the Database Name list becomes unavailable to
select a database name. Type a database name in
the box.

Default Value:

None

Enter Database Name Definition:

Specifies that a custom database name is entered
in the Database Name field.

Allowed Values:

• Deselected - Specifies to select a database
name from the Database Name list.

• Selected - Specifies to type a database name
in the Database Name field.

Default Value:

Deselected
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Field Name Definition

OK Function:

Generates the connection string.
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Process Template Management
The Process Template Management section of the Enterprise Manager Main Page allows the administrator to
perform certain functions to process templates that have been deployed to AgilePoint Server such as adding a
process template, deleting a process template, check out/in process templates, saving a process template as
XML, and checking process templates for AgilePart/AgileWork dependencies.

Add a Process Template
This function allows the administrator to upload XML-formatted AgilePoint process template files to AgilePoint
Server.

1. On the Enterprise Manager Main Page, click the Process Templates link. The Process Templates page
appears.

2. Click the Add button. The Add Process Template page appears.

3. Select the time you would like the process template to be released:

• Release Later – Adds the process template to the repository, but does not release it.

• Release Now – Releases the process template as soon as it's added.

• Release On – Releases the process template at a time you specify.

4. Click Browse, and select the XML-formatted AgilePoint process template for which you would like to add.

5. Click Submit. The XML-formatted AgilePoint process template is added to Enterprise Manager.

Delete a Process Template
This function allows the administrator to delete a process template from AgilePoint Server.

1. On the Enterprise Manager Main Page, click the Process Templates link. The Process Templates page
appears.

2. Click the option button next to the process template for which you would like to delete and click the Delete
button.

Check Out and In a Process Template
This function allows the administrator to check in/out a process template for modification. This prevents more
than one user from updating the same process template at the same time. When you want to revise the XML-
formatted AgilePoint process template, first do Check Out from the Process Templates page in Enterprise
Manger. You will now modify the original process template in Envision. When you have the new version of the
template ready to upload (save again as XML in Envision), do Check In from the Process Templates page and
check in the latest XML file that you generated. It will prompt you for the new version number. When you check-
in a new version of a process model directly from AgilePoint Enterprise Manager, it will be loaded into AgilePoint
Server with the status Created, but it will not be automatically Released. You can therefore deploy all of your
process model changes to AgilePoint, and then "Release" all of the new versions once all of the changes are
deployed.
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Save as File
The Save as File function allows the administrator to save a process template as XML. Once the process
template XML is saved, it can be imported into AgilePoint Envision and saved as a .vsd file. This can be helpful if
you have lost your master process template .vsd and want to recover it.

Good to Know

• When you import the XML version of the process model, some formatting may be lost. The images for some
AgileShapes do not get imported, and some reformatting may occur, but the process functions as designed.

Navigation

1. On the Enterprise Manager Main Page, click the Process Templates link.

Instructions

1. On the Process Templates page, select the process template for which you would like to save as a XML file
and click the Save as File button. The Save Process Template File page appears.

2. Click the Download link and save the .zip file to the desired directory.

3. The process template XML file can now be imported into Envision via File > Export & Import > Import
Process Template XML and saved as a .vsd file.

Find AgilePart and AgileWork
The Find AgilePart and AgileWork function allows the administrator to search for AgileParts and AgileWorks in
deployed process templates. This function can be used for analyzing the dependencies of a process template.
For example, the administrator can see what AgileParts/AgileWorks (and the version) are associated with a
process template.

1. On the Enterprise Manager Main Page, click the Process Templates link. The Process Templates page
appears.

2. Click the Find AgilePart & AgileWork button. The Find AgileParts or AgileWorks page appears.
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3. Enter the search criteria in the text boxes provided. For example, in the AgilePart/AgileWork text box, type
the AgilePart/AgileWork assembly name and click Find. You can also search on process template name or
process template version.
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Note:  Wild cards are accepted for all the search text boxes. For example, you can type
Ascentn.AgilePart* as shown above to return all AgileParts that begin with the assembly name
Ascentn.AgilePart.

Process Templates Page
This page allows the administrator to review, search for, and update (e.g. check out) the individual AgilePoint
process templates deployed to AgilePoint Server. The Process Templates page also allows the administrator to
examine process templates for AgilePart and AgileWork dependencies.

The Process Templates page is pictured below:

Upload Process Template File Window
Specifies the details for checking in a process model as an XML file.
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Navigation

1. On the Enterprise Manager Main Page, click Process Templates.

2. On the Process Templates page, select the process template you want, and then click Check-in.

Field Definitions

Field Name Definition

Process Template Definition:

Displays the name of your process model.

Allowed Values:

Read only.

Release Options Definition:

Specifies when to release the process model.

Allowed Values:

• Release Later - Checks in the process template
to the repository, but does not release it.

• Release Now - Releases the process template
as soon as it is checked in to the repository.

• Release On - Releases the process template at
a particular time you specify.

Default Value:
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Field Name Definition

Release Later

Current Version Definition:

Displays the current version number of the file you
are checking in to the repository.

Allowed Values:

Read only.

New Version Definition:

Specifies the new version number of the file you are
checking in to the repository.

Allowed Values:

A valid file version number.

• A major file version number - A whole number

• A minor file version number - [major version
number].[minor version number]

• Blank (null) - If you do not enter any number,
the last number in the current version number is
incremented.

Default Value:

None

Custom Attributes:

No

Example:

• A major file version number - 1 or 1.0

• A minor file version number - 1.3

In this example, 1 is the major version; 3 is the
minor version.

Process Template File (xml) Definition:

Displays the file name for your XML process model.

Allowed Values:

Read only - The file name is populated when you
select the file using the Browse button.

Comment Definition:

Specifies optional, free text comments about the file
version or check-in procedure.

Allowed Values:
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Field Name Definition

Multiple line of text.

Default Value:

None.

Custom Attributes:

No
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Runtime Management
The Runtime Management section of the Enterprise Manager Main Page allows the administrator to perform
certain functions such as suspend/resume, rollback, cancel, and migrate process instances, and manage task
and notifications.

Find a Process Template
This function allows the administrator to find the desired process instance(s).

1. On the Enterprise Manager Main Page, click the Processes link. The Processes page appears.

2. Click the Find button. The Find Process(es) page appears.
 

 

3. Enter the search criteria and click OK. The process(es) that match the specified criteria are returned. The
process instance link opens the Process page that can be used to drill down into the process to expose
detailed information about the process instance.
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Suspend a Process
To suspend a running process, do the following.

Prerequisites

• A running process instance.

Navigation

Find the process instance you want to manage:

1. On the Enterprise Manager Main Page, click the Processes link. The Processes page appears.

2. Click Find. The Find Process(es) page appears.

3. Enter the search criteria for your process, and click OK. The processes that match the specified criteria are
displayed.

Instructions

1. In the search results on the Find Process(es) page, select your process instance.

2. On the Enterprise Manager Main Page, click the Tasks link. The Tasks page appears.

3. Click Suspend.

Resume a Suspended Process
To resume a suspended process, do the following.
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Prerequisites

• A suspended process instance.

Navigation

Find the process instance you want to manage:

1. On the Enterprise Manager Main Page, click the Processes link. The Processes page appears.

2. Click Find. The Find Process(es) page appears.

3. Enter the search criteria for your process, and click OK. The processes that match the specified criteria are
displayed.

Instructions

1. In the search results on the Find Process(es) page, select your process instance.

2. Click Resume.

Roll back within a Process Instance
To roll back a process instance to a specified activity, do the following.

Prerequisites

• A running process instance.

Navigation

Open the Process Detail page for the process you want to manage:

1. On the Enterprise Manager Main Page, click the Processes link. The Processes page appears.

2. Click Find. The Find Process(es) page appears.

3. Enter the search criteria for your process, and click OK. The processes that match the specified criteria are
displayed.

4. In the search results on the Find Process(es) page, click the process name. The process detail page
appears.

Instructions

1. On the process detail page, click Rollback & Skip. The Select Destination Activity page appears.
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2. In the Rollback to box, select the activity to which you want to rollback, and click OK.

Skip within a Process Instance
To skip forward within a process instance to a specified activity, do the following.

Prerequisites

• A running process instance.

Navigation

Open the Process Detail page for the process you want to manage:

1. On the Enterprise Manager Main Page, click the Processes link. The Processes page appears.

2. Click Find. The Find Process(es) page appears.

3. Enter the search criteria for your process, and click OK. The processes that match the specified criteria are
displayed.

4. In the search results on the Find Process(es) page, click the process name. The process detail page
appears.



Runtime Management 40

AgilePoint BPMS v5.0 R2 SP1 Enterprise Manager Administrator's Guide r5.4.15

Instructions

1. On the process detail page, click Rollback & Skip. The Select Destination Activity page appears.
 

 

2. In the Skip to box, select the activity to which you want to skip, and click OK.

Bypass or Update a Delay
To update or bypass the delay on the Delay AgilePart during runtime, do the following. This can prevent a
process from becoming stuck because circumstances change the requirements for a delay while a process
instance is running. Examples include schedule changes due to project requirements or participants' availability.

Prerequisites

• A running process instance that is waiting to move forward based on a delay set by the Delay AgilePart.

Navigation

Open the Process Detail page for the process you want to manage:



Runtime Management 41

AgilePoint BPMS v5.0 R2 SP1 Enterprise Manager Administrator's Guide r5.4.15

1. On the Enterprise Manager Main Page, click the Processes link. The Processes page appears.

2. Click Find. The Find Process(es) page appears.

3. Enter the search criteria for your process, and click OK. The processes that match the specified criteria are
displayed.

4. In the search results on the Find Process(es) page, click the process name. The process detail page
appears.

5. Click the Process Monitor tab.

Instructions

1. On the Process Monitor tab, page, click the Delay AgilePart you want to update, and then click Update
Delay.

2. On the Update Delay dialog box, do one of the following, and then click OK:

• To simply bypass the delay and move the process forward, click Bypass Delay.

• To update the date and time on which the delay should expire, click Update Delay, and then set the
date and time you want.

Cancel a Process Instance
To cancel (manually stop) a process instance, do the following.

Note that it is also possible to cancel a process instance using the Process Instance List web part in SharePoint.

Prerequisites

• A process instance in any status other than Completed or Canceled.

Navigation

Find the process instance you want to manage:

1. On the Enterprise Manager Main Page, click the Processes link. The Processes page appears.

2. Click Find. The Find Process(es) page appears.

3. Enter the search criteria for your process, and click OK. The processes that match the specified criteria are
displayed.

Instructions

1. In the search results on the Find Process(es) page, select your process instance.

2. Click Cancel.

Once a process instance is canceled, all assigned tasks will be removed from the participants' task lists.

Migrate a Process Instance
You can migrate a suspended process instance from one process template version to another version at run
time without losing any of the information collected prior to migration. You can migrate to a newer version or an
older version of a process instance.
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This feature enhances the exception handling capabilities by allowing you to select from a list the process
instance for which you would like to migrate for handling the specific exception at hand.

Prerequisites

• A running process instance.

Navigation

Suspend your process:

1. On the Enterprise Manager Main Page, click the Processes link. The Processes page appears.

2. Click Find. The Find Process(es) page appears.

3. Enter the search criteria for your process, and click OK. The processes that match the specified criteria are
displayed.

4. In the search results on the Find Process(es) page, select your process instance.

5. Click Suspend.

Instructions

1. In the search results on the Find Process(es) page, click the process name. The process detail page
appears.

2. Click Migrate. The Select Version of Process Template page appears.

3. Select the process instance for which you would like to migrate to and click OK.

4. Use the Migrate Process window to view information about the current process instance activities as well as
the activities of the new process instance.

The following options are available:

• All - Shows all activities in both the source and destination process instances.

• Left Only - Shows all activities in the source process instance.
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• Right Only - Shows all activities in both the destination process instance.

• Difference - Shows the activities in destination process instance that are not included in the source
process instance.

5. If you want to perform bulk migration to migrate multiple process instances using the same options, select
Save the migration instruction.

6. Click Apply. The suspended process instance is migrated to the new process instance.

7. If you selected Save the migration instruction, the file Instruction_[ID].xml opens in a new browser
window. Save this file to the folder [AgilePoint Server installation folder]\Tools\

For more information, see Bulk Migration.

8. Resume the process instance to bring it to a running state.

Bulk Migration
You can perform a bulk migration on multiple process instances once you have migrated an individual process
instance.

Prerequisites

• A file named Instruction_[ID].xml that was generated by previously migrating a process instance.

If you followed the instructions for migrating a process instance, this file should reside in [AgilePoint Server
installation folder]\Tools\.

However, the default folder is [AgilePoint Enterprise Manager installation folder]\tmp.

http://documentation.agilepoint.com/SupportPortal/DOCS/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html#kbDefaultInstallLocations.html
http://documentation.agilepoint.com/SupportPortal/DOCS/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html#kbDefaultInstallLocations.html
http://documentation.agilepoint.com/SupportPortal/DOCS/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html#kbDefaultInstallLocations.html
http://documentation.agilepoint.com/SupportPortal/DOCS/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html#kbDefaultInstallLocations.html
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• The process instances you want to migrate must match the original process instance exactly to be included
in the bulk migration. For example, the target process instances must be at the same running state as the
original process instance.

Navigation

Open the APADM Utility Tool:

1. Open the following file:

[AgilePoint Server installation]\Tools\apadm.exe

Instructions

1. Run the following APADM command line prompt:

apadm –mgproc  [Process Migration Instruction XML File]
   [AgilePoint Server URL]

The command prompt window provides the status of each process instance migration.

Note:  To rollback, migrate all process instances back to the desired version.

Partial Rework
Partial rework is the capability to dynamically modify or "redo" a previously completed activity without interrupting
the overall flow of the process instance.

When you create a partial rework, the task you want to rework is added to the current task as an additional Work
to Perform.

This differs from a rollback, in that the entire process does not roll back to the previously completed activity. Only
the identified activity is considered.

Prerequisites

• A running process instance with at least one manual activity in Completed status, and at least one manual
activity in Active status.
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Instructions

1. On the Enterprise Manager Main Page, click Partial Rework.

2. On the Partial Rework page, in the Process Template list, select your process template.

3. In the Running Process Instances list, select your process instance.

4. In the Active Manual Activity(s) list, select the activity to which you want to add the reworked task.

5. In the Tasks To Rework list, select the tasks you want to rework.

6. Click Apply.

The tasks you selected in the Tasks To Rework list are added as Works to Perform to the activity you selected
in the Active Manual Activity(s) list.

Workload Balance
Workload Balancing is a tool for viewing information associated with the Work Load Balance Agile Work, where it
is shown, the number of global tasks assigned to a user in a particular group.

Pseudo Tasks
A pseudo task is an item that appears in the Task List of one user in order to monitor or manage the task of
another user.

The most common use case for a pseudo task is a manager who wants to monitor the tasks of their
subordinates. A pseudo task appears in the manager's task list, where he can view the subordinate's task status,
and manage the task. The manager, however, cannot complete the task.

A pseudo task will not block the process from moving forward.

In the following example, the process model includes three activities.

• Submit

• Manager Approval

• CFO Approval

The CFO wants to monitor the Manager Approval tasks. A pseudo task at the CFO activity will be created to
track the Manager Approval.

To add a pseudo task:
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1. Initiate a Process and complete the Submit activity.

2. Logon to Enterprise Manager.

3. Click on Shadowing and Monitoring link in the Process Adaptation section.

4. Select the Budget Request Process.

5. Select the CFO Approval from the Work To Perform drop-down list and select the user.

6. Click Create.

7. You can see a task has been created with status carbon.

This task will be completed in two cases:

• If the user completes their own task.

• If the task gets canceled, if all the tasks are completed.
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View Activities
The Activities tab allows the administrator to review detailed information about the activities associated with the
process.

The following information about each activity is available:

• Name of the activity

• Session for which this activity was completed

• Status of the activity (e.g. Active, Passed, Canceled)

• Start date for the activity

• Completion date for the activity

View Tasks
The Tasks tab allows the administrator to review detailed information about the manual activities associated with
the process.

The following information about each manual activity is available:

• Name of the manual activity

• Original user

• Assigned user

• Description of the activity

• Session for which this activity was completed

• Status of the activity (e.g. Removed, Completed, Canceled)

• Date the activity was assigned

• Due date for the activity

• Completion date of the activity

• Cancellation date of the activity
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View the Event Log
The Event Log allows the administrator to review particular events that occurred during the execution of the
process instance.

The event log displays the following information:

• Name of the event

• Process participant associated with the event

• Status of the event

• Date the event was triggered

• Date the event completed

Prerequisites

• At least one process instance in any status.

Navigation

Open the Process Detail page for the process you want to manage:

1. On the Enterprise Manager Main Page, click the Processes link. The Processes page appears.

2. Click Find. The Find Process(es) page appears.

3. Enter the search criteria for your process, and click OK. The processes that match the specified criteria are
displayed.

4. In the search results on the Find Process(es) page, click the process name. The process detail page
appears.
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Instructions

1. On the process detail page, click the Event Log tab.

View the Process Monitor
The Process Monitor tab allows the administrator to view a process instance in real-time status within the
process viewer.

Note that the process viewer can also be accessed by process participants through the SharePoint and
ASP.NET Task List web parts.

Prerequisites

• At least one process instance in any status.

Navigation

Open the Process Detail page for the process you want to manage:

1. On the Enterprise Manager Main Page, click the Processes link. The Processes page appears.

2. Click Find. The Find Process(es) page appears.

3. Enter the search criteria for your process, and click OK. The processes that match the specified criteria are
displayed.

4. In the search results on the Find Process(es) page, click the process name. The process detail page
appears.
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Instructions

1. On the process detail page, click the Process Monitor tab.

View Data
The Data tab allows the administrator to review the custom process attributes and values that have been used in
the process instance.

The following information is available:

• Name of the custom attribute

• Date type of the custom attribute

• Value associated with the custom attribute

View InfoPath XML Data
For MS InfoPath based processes, you can view additional XML data from the InfoPath form. In order
to access this information, you must add a line to the file [AgilePoint Enterprise Manager installation
folder]\web.config as shown below.

<add key="ShowXml" value="true" />

http://documentation.agilepoint.com/SupportPortal/DOCS/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html#kbDefaultInstallLocations.html
http://documentation.agilepoint.com/SupportPortal/DOCS/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html#kbDefaultInstallLocations.html
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After adding this line, you will now see the Click to view XML data link.

Click the Click to view xml data link. The XML of the MS InfoPath form is displayed in a browser window.
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Find Tasks
To find tasks current or past tasks in the AgilePoint system, do the following.

Prerequisites

• At least one process instance in any status.

Instructions

1. On the Enterprise Manager Main Page, click the Tasks link. The Tasks page appears.

2. Click the Find button. The Find Tasks page appears.

3. Enter the search criteria and click OK. The tasks that match the specified criteria are returned along with
information such as the Work to Perform and Status.

Mark a Task as Complete
To manually mark a task as complete, do the following.
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Prerequisites

• A running process instance.

Navigation

Find a task:

1. On the Enterprise Manager Main Page, click the Tasks link. The Tasks page appears.

2. Click the Find button. The Find Tasks page appears.

3. Enter the search criteria and click OK. The tasks that match the specified criteria are returned along with
information such as the Work to Perform and Status.

Instructions

1. On the Find Tasks page, select your task.

2. Click Mark Completed.

Reassign a Task
To reassign a task to a different participant, do the following.

Prerequisites

• A running process instance.

Navigation

Find a task:

1. On the Enterprise Manager Main Page, click the Tasks link. The Tasks page appears.

2. Click the Find button. The Find Tasks page appears.

3. Enter the search criteria and click OK. The tasks that match the specified criteria are returned along with
information such as the Work to Perform and Status.

Instructions

1. On the Find Tasks page, select your task.

2. Click Reassign.

3. Browse to select the new participant.

4. Click Submit.

Manage Notifications
This function allows the administrator to review, search for, and update (e.g. cancel or resend) the individual
email notifications managed by AgilePoint Server.

To manage notifications:
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1. On the Enterprise Manager Main Page, click the Notifications link. The Notifications page appears.

2. Click the Find button. The Find Notifications page appears.

3. Enter the search criteria and click OK. The notifications that match the specified criteria are returned along
with information about the notifications associated with the process instance such as "Sent by" and "Status".

To resend a notification:

1. Click the check box next to the notification for which you would like to resend.

2. Click Resend.

To cancel a notification:

1. Click the check box next to the notification for which you would like to cancel.

2. Click Cancel.

Event Service Page
This page allows the administrator to initiate processes automatically via scheduling, email, database, or file
dropping. All event listeners can be configured via AgilePoint Enterprise Manager.

Note:  The Event Service AgileConnector must be added via the AgilePoint Server Configuration utility
before using the Event Service.

Trigger a Process Based on a Schedule
The trigger a process based on a schedule allows you to automatically trigger an AgilePoint process based on a
defined schedule (can be one time or recurring).

To trigger an AgilePoint process based on a schedule:

1. From the Schedule section, click the Add button. The Schedule Event Setting page appears.
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2. Enter a description for the trigger.

3. Select a period for the trigger.

4. Configure the Recurrence Pattern.

The Hour option indicates an hour of the day on a 24-hour clock, and the Minute option indicates a minute
during that hour. Select Every Hour to indicate an event that occurs at a particular minute of every hour
(for example, 8:30, 9:30, 10:30, and so on). Select Every Minute to indicate an event that occurs once per
minute during a specified hour.

If you want to configure an event to recur at a specified number of hours or minutes, select Recur Every, and
then set the number of hours or minutes.

5. Select the Process Template to be triggered.

6. Check the Enable this schedule check box to activate the trigger.

7. Click OK. Notice that the trigger is now added to the list.
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8. Click the Edit button or Delete button to edit or delete the trigger.

Trigger a Process Based on an Incoming Email
The trigger a process based on an incoming email allows you to automatically trigger an AgilePoint process
based on an incoming email.

To trigger an AgilePoint process based on an incoming email, do the following.

Navigation

1. On the Enterprise Manager Main Page, click Events Service.

2. On the Event Service page, click Incoming Email > Add.

Instructions

1. On the Inbound Email Event Configuration page, complete the following fields as required.

Field Name Definition

Description Definition:

Specifies the description of the email trigger.

Allowed Values:

Multiple lines of text.

Default Value:

None

Custom Attributes:

No

Domain Definition:

Specifies your email authentication domain.

Allowed Values:

A valid domain name.

Default Value:
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Field Name Definition

None

Custom Attributes:

No

User Name Definition:

Specifies a user name you want to associate with
an email event.

Allowed Values:

A valid user name.

Default Value:

None

Custom Attributes:

No

Password Definition:

Specifies the password for your email server.

Allowed Values:

A single line of text with no spaces.

Default Value:

None

Custom Attributes:

No

Email Subject Definition:

Specifies a custom attribute that contains to
the subject of your email. When the email
account specified receives an email, the data
associated with this attribute is stored. It can then
be referenced in the process using the specified
custom attribute.

Allowed Values:

A valid custom attribute.

Default Value:

None

Custom Attributes:

Yes
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Field Name Definition

Sender Definition:

Specifies a custom attribute that contains to the
sender of your email. When the email account
specified receives an email, the data associated
with this attribute is stored. It can then be
referenced in the process using the specified
custom attribute.

Allowed Values:

A valid custom attribute.

Default Value:

None

Custom Attributes:

Yes

Mail Body Definition:

Specifies a custom attribute that contains to the
body of your email. When the email account
specified receives an email, the data associated
with this attribute is stored. It can then be
referenced in the process using the specified
custom attribute.

Allowed Values:

A valid custom attribute.

Default Value:

None

Custom Attributes:

Yes

Mail Body Format Definition:

Specifies the content format for the custom
attribute that contains body of an email.

Allowed Values:

• HTML - Stores the content in HTML format.

• TEXT - Stores the content in text-only format.

• Both HTML & TEXT - Stores 2 copies of the
content: 1 in HTML, and 1 in text-only format.

Default Value:

HTML
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Field Name Definition

Custom Attributes:

No

Attachment Definition:

Specifies the name of a process attribute that
stores the path and file name of the email
attachment on the AgilePoint Server machine.

The attachments are stored on AgilePoint Server
in the format [Attachment Location]\[sender email]
- [process instance ID]\[file name]

Allowed Values:

A text string with no spaces or special characters.

Default Value:

None

Example:

MyAttachments

Attachment Location Definition:

The base file path where attachments from the
email event service are stored.

When AgilePoint Server stores the files, it places
them in an auto-generated subfolder.

Allowed Values:

A valid folder path (without the file name) on the
AgilePoint Server machine.

Default Value:

None

Example:

C:\Files\MyAttachments

Cc Definition:

Specifies a custom attribute that stores the CC
recipients of an email.

Allowed Values:

A custom attribute.

Default Value:

None
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Field Name Definition

Custom Attributes:

Yes

Priority Definition:

Specifies a custom attribute that stores the priority
of an email.

Allowed Values:

A custom attribute.

Default Value:

None

Custom Attributes:

Yes

Received Date Definition:

Specifies a custom attribute that stores the
received date of an email.

Allowed Values:

A custom attribute.

Default Value:

None

Custom Attributes:

Yes

Mail Server Definition:

Specifies your email server type.

Allowed Values:

• MS Exchange

• POP3

• IMAP

• EWS

Default Value:

POP3

Custom Attributes:

No
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Field Name Definition

Exchange Server Name Definition:

Specifies the URL for your email server.

Allowed Values:

A valid email server URL.

Default Value:

None

Custom Attributes:

No

Allow Duplicate Attachments Definition:

Specifies how to handle multiple emails with the
same attachment file.

Allowed Values:

• Deselected - Saves the first attachment file
and ignores the subsequent attachments with
the same file name and extension.

• Selected - Saves all the duplicate
attachment, and appends the incremented
number at the end of the file name. AgilePoint
Server kicks off a new process for each
duplicate, as if it were a unique file.

Default Value:

Deselected

Example:

test.txt, test(1).txt, test(2).txt , test.png,test(1).png

Process Template Definition:

Specifies the process template for which you want
the email trigger to create a process instance.

Allowed Values:

A process template name from the list.

Default Value:

None

Custom Attributes:

No

Enable this schedule Definition:
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Field Name Definition

Specifies whether the email trigger is active.

Allowed Values:

• Deselected - Specifies that the email trigger
is inactive.

• Selected - Specifies that the email trigger is
active.

Default Value:

None

Custom Attributes:

No

Trigger a Process Based on a File Drop
The trigger a process based on a file drop allows you to automatically trigger an AgilePoint process based on
when a file is copied to a location and also is based on the type of file that is added.

To trigger an AgilePoint process based on a file drop:

1. From the File Dropping section, click the Add button. The File Dropping Event Configuration page appears.
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2. Enter a description for the trigger.

3. Enter the folder name and file type. File type accepts multiple values separated by a semicolon.

Note:  You can also configure to monitor a subfolder. Be cautious of performance issue if your folder
depth is too deep.

4. (Optional) Use the File Attribute Binding section to specify Custom Attributes (for the Folder Path, File
Name, File Type, File Size, and File Created Date) to be set when the process is initiated. When a file is
dropped to the specified location, and the process is triggered, the data associated with the Folder Path, File
Name, File Type, File Size, and File Created Date will be stored and can be referred to in the process as the
Custom Attribute that you defined.

5. Select the Process Template to be triggered.

6. Check the Enable this schedule check box to activate the trigger.

7. Click OK. Notice that the trigger is now added to the list.
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8. Click the Edit button or Delete button to edit or delete the trigger.

Trigger a Process Based on a Database Update
The trigger a process based on a database update allows you to automatically trigger an AgilePoint process
based on when a new table row is added to a database.

Note:  Only Microsoft SQL Server is supported at this time.

Note:  As a best practice it is recommended to use a separate database table that is used for the
Database Update monitoring, this is because once the new database update process is triggered, the
new database table row and records will be deleted.

To trigger an AgilePoint process based on a database event:

1. From the Database Update section, click the Add button. The Database Update Event Setting page
appears.
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2. Enter a description for the trigger.

3. Enter the database connection string manually or click the Build Connection String button for assistance
in building the connection string. In the Connection String Builder page, enter the data source and user
authentication fields and click the Retrieve Database button to retrieve the database name, if you know the
database name, you can also check the Enter Database Name check box and type the database name
directly into the text box. When finished, click OK, the connection string is built for you.

4. After the connection string is generated, specify which table you want to monitor and what is primary key
for that table. It is important to ensure that the Primary key is defined properly. Once the event listener
successfully initiates a process by retrieving the data from the table specified, it will delete the records. As
mentioned above, as a best practice it is recommended to use a separate database table that is used for the
Database Update monitoring, this is because once the process is triggered, the new database table row and
records will also be deleted.

5. (Optional) Use the Column List section to specify Custom Attributes for the columns. One Custom Attribute
can only bind to one column, but one column can be assigned to different Custom Attributes.

6. Select the Process Template to be triggered.

7. Check the Enable this schedule check box to activate the trigger.

8. Click OK. Notice that the trigger is now added to the list.
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9. Click the Edit button or Delete button to edit or delete the trigger.
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Access Control
The Access Control section of the Enterprise Manager Main Page allows the administrator to perform certain
functions such as create or modify users, roles, or groups, and delegate, or reassign, user tasks.

Add a User
To add an existing user that is not registered to the AgilePoint system, do the following.

Prerequisites

• An existing user account.

Navigation

1. On the Enterprise Manager Main Page, click Users.

2. On the Users window, click Add.

Instructions

1. Complete the following required fields on the Add window.

Field Name Definition

User Name Definition:

Specifies the user account you want to register in
AgilePoint.

Allowed Values:

A user name, including the domain name, in the
following format:

[domain]\[user name]

Default Value:

None

Custom Attributes:

No

Example:

MyDomain\Administrator

Full Name Definition:

Specifies the full name of the user.

Allowed Values:
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Field Name Definition

A text string that can contain spaces.

Default Value:

None

Custom Attributes:

No

2. On the Add or Edit User Information Window, complete any additional configuration for this user according to
your requirements.

Pages
This section provides a description of the pages in the Access Control section of Enterprise Manager.

Users Page
This page allows the administrator to view, search for, and update the user account information that is used by
AgilePoint Server.
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Add or Edit User Information Window
This dialog allows the administrator to add or edit an AgilePoint Server user's information.

Navigation

1. On the Enterprise Manager Main Page, click Users.

2. On the Users window, click Add or Edit.

Field Definitions

Field Name Definition

User Name Definition:

Specifies the user name you want.

Allowed Values:
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Field Name Definition

Read only.

Full Name Definition:

Specifies the full name of the user.

Allowed Values:

A text string that can contain spaces.

Default Value:

None

Custom Attributes:

No

Email Address Definition:

The user's email address.

Allowed Values:

A valid email address.

Default Value:

None

Custom Attributes:

No

Language Definition:

Specifies the language of the user.

Allowed Values:

The language you want.

Default Value:

None

Custom Attributes:

No

Title Definition:

Specifies the job title of the user.

Allowed Values:

The name of your job title.

Default Value:

None
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Field Name Definition

Custom Attributes:

No

Department Definition:

Specifies the company's department the user
belongs to.

Allowed Values:

A text string that can contain spaces.

Default Value:

None

Custom Attributes:

No

Manager Definition:

Specifies the manager of the user reports to.

Allowed Values:

The user name of your manager.

Default Value:

None

Custom Attributes:

No

Yammer ID Definition:

Specifies the user's Yammer ID.

Allowed Values:

A valid Yammer ID.

Default Value:

None

Lync ID Definition:

Specifies the user's Lync ID.

Allowed Values:

A valid Lync ID.

Default Value:

None
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Field Name Definition

Chatter ID Definition:

Specifies the user's Chatter ID.

Allowed Values:

A valid Chatter ID.

Default Value:

None

SMS No Definition:

Specifies a user's telephone number where he or
she can receive SMS messages.

Allowed Values:

A telephone number with integers only and no
special characters.

Default Value:

None

Reserve a permanent license seat for this user Definition:

When selected, specifies that the user is reserved
a permanent license seat under the floating license
scheme.

When a license is reserved, the user's license seat
is removed from the pool of floating licenses, and
the license never expires. This is typically used for
frequent or high value AgilePoint users who need
system access.

Allowed Values:

• Deselected - Specifies that the user uses the
default floating license scheme.

• Selected - Specifies that a non-expiring license
seat is reserved for the user.

Default Value:

Deselected

Add User From Active Directory Dialog
This dialog allows the administrator to add new AgilePoint Server users from an Active Directory data source.

Requirements:
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• The AgilePoint System User (as defined in the AgilePoint Server Configuration utility) should belong to the
Active Directory domain.

• AgilePoint Server's Application Pool's Identity user account (as configured in IIS) needs to have read
permissions to the Active Directory server and data.

View Access Rights dialog
This dialog allows the administrator to view the complete set of AgilePoint access rights possessed by a specific
AgilePoint Server user.
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Organization Information Dialog
This dialog allows the administrator to configure the organization information that can be assigned to the
AgilePoint Server users.
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Roles Page
This page allows the administrator to view and update the roles that can be assigned to AgilePoint Server users.



Access Control 77

AgilePoint BPMS v5.0 R2 SP1 Enterprise Manager Administrator's Guide r5.4.15

Role Window
Creates or edits a role for AgilePoint users.
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Navigation

1. On the Enterprise Manager Main Page, click Roles.

2. On the Roles window, click Add Role or Edit Role as appropriate.

Field Definitions

Field Name Definition

Role Name Definition:

Specifies the name of a role.

Allowed Values:

A text string that can contain spaces.

Default Value:

None

Custom Attributes:

No

Example:

Administrator

Description Definition:

A free text description of the role.

Allowed Values:

Multiple lines of text.

Default Value:

None.

Custom Attributes:

No

Rights Definition:

Determines the privileges to be provided to a role.

Allowed Values:

Role Access Rights

Default Value:

None
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Role Access Rights

This topic provides a list of access rights.

Access Rights Description  

Register and modify the user
information

Adds a user and modifies the user
information.

Unregister a user Removes a user from the
AgilePoint system.

 

Add and modify the role information Adds and modifies a role.  

Remove a role Deletes a role.

Add and modify the group
information

Adds and modifies a group.  

Remove a group Deletes a group.  

Modify/View the system
configuration

Modifies the AgilePoint system
configuration. You can also view
the system configuration.

 

Add a process template Adds a process template.  

Checkin and checkout a process
template

Checks in and checks out a
process template from a repository.

 

Delete and disable a process
template

Deletes and disables a process
template.

 

Release a process template Releases a process template.  

Initiate a process Initiates a process.  

Suspend and resume a process Suspends and resumes a process.  

Resend and cancel an email
notification

Resends and cancels an email
notification.

 

Cancel a process Cancels a process.  

Rollback a process Rollbacks a process.  

Reassign a task Reassigns a task to another user.  

Cancel a task Cancels a task.  

Create a task Creates a task.  
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Access Rights Description  

Add, remove, and modify
delegation

Adds, removes, and modifies
delegation.

 

Add, remove, and modify report
configuration

Adds, removes, and modifies report
configuration.

 

Archive and restore process(es) Archives and restores processes.  

Add, remove, and modify shared
custom attributes

Archives and restores processes.  

View process details Allows to view process details.  

Mark automatic work item
completion

Marks an automatic work item as
completed by an asynchronous
activity.

 

Add/Edit Role Dialog
This dialog allows the administrator to add or edit a role.
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Global E-mail Templates Page
This page allows the administrator to add, update, and delete e-mail templates that AgilePoint Envision users
can apply to create emails.  You can use email templates to apply default values to an email, such as To, From,
CC, BCC, subject, and body. Business users can apply the email templates in AgilePoint Envision.

Add a Global Email Template
You can create a global email template, which all Envision users can use to create email notifications.

1. On the Enterprise Manager Main Page, click the Global Email Templates link. The Global Email Templates
page appears.

2. Click the Add button. The Global Email Templates pop-up appears.
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3. On the Global Email Templates pop-up, enter the information you would like to include in the global email
template. Note that when Envision users select this template, they can modify it for their needs as required.
For more information, see Email Template Wizard in the Documentation Library.

4. When you have finished, click Add Template.

Remove a Global Email Template
You can delete, or remove, a global email template.

1. On the Enterprise Manager Main Page, click the Global Email Templates link. The Global Email Templates
page appears.

2. On the Global Email Templates page, select the templates you want to remove, and click the Remove
button.
 

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
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Edit a Global Email Template
You can edit a global email template that has already been created.

1. On the Enterprise Manager Main Page, click the Global Email Templates link. The Global Email Templates
page appears.
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2. On the Global Email Templates page, select the templates you want to edit, and click the Edit button. The
Global Email Templates pop-up appears.

3. On the Global Email Templates pop-up, enter or modify the information you would like to include in the
global email template. Note that when Envision users select this template, they can modify it for their needs
as required. For more information, see Email Template Wizard in the Documentation Library.

4. When you have finished, click Update Template.

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
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Enterprise Social Token Management Page
Displays and manages the list of enterprise social tokens. These tokens enable you to connect to third-party
social media services, such as Yammer. From this page, you can add, edit, or delete enterprise social tokens.

Navigation

1. On the Enterprise Manager Main Page, click Enterprise Social Token Management.

Field Definitions

Field Name Definition

Add and Edit Opens the Following Window:

Add/Edit Global Application Setting Page

Purpose of this Window:

Adds or modifies the information for a global
application setting, such as an Enterprise Social
Token.

Remove Function:

Removes the selected application name from the
Enterprise Social Token Management.

Add/Edit Global Application Setting Page
Adds or modifies the information for a global application setting, such as an Enterprise Social Token.
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Navigation

1. On the Enterprise Manager Main Page, click Enterprise Social Token Management.

2. On the Enterprise Social Token Management window, click Add or Edit as appropriate.

Field Definitions

Field Name Definition

Application Type Definition:

Specifies the third-party application, such as
Yammer or Chatter.

Allowed Values:

A list of supported enterprise social applications.

Default Value:

Yammer

Access Token Name Definition:

Specifies the unique name for your connection to
the enterprise social application.

Allowed Values:

An alphanumeric string that can include spaces.

Default Value:

None
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Field Name Definition

Consumer Key Definition:

Specifies the client ID of the app you created or
added in your third-party application service, such
as Yammer.

Allowed Values:

An alphanumeric string.

Default Value:

None

Consumer Secret Definition:

Specifies your client secret of the app you created
or added in your third-party application service,
such as Yammer.

Allowed Values:

An alphanumeric string.

Default Value:

None

Authorization URL Definition:

Specifies the standard authorization URL exposed
by the third-party application service to obtain your
authorization code.

Allowed Values:

A valid authorization URL.

Enterprise Manager completes this field
automatically for supported applications. Do not
change the default value.

Default Value:

An required authorization URL for the social
application.

Access Token URL Definition:

Specifies the standard URL exposed by the third
party application service that is used to obtain an
access token.

Allowed Values:

A valid URL.
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Field Name Definition

Enterprise Manager completes this field
automatically for supported applications. Do not
change the default value.

Default Value:

The standard URL to retrieve the access token from
your social application.

Get Access Token Function:

Sends a request to your third-party application
service to get the authorization code, and then the
access token.

To complete this process, you must log on to your
third-party application, and specify your consent
when prompted.

Authorization Code Definition:

Specifies the authorization code supplied by your
social application.

Allowed Values:

A valid authorization code.

This value is completed by your social application.

Default Value:

An unique authorization code.

Access Token Definition:

Specifies an access token, or code, supplied by
your social application.

Allowed Values:

A valid token.

This value is completed by your social application.

Default Value:

An unique token.

Instance Name Definition:

Specifies URL of the SalesForce account to which
the current token connects. This is the Misc field
AgilePoint displays to identify the environment this
token is accessing.

This field applies to Chatter only. For Yammer
applications, the Misc field refers to the Network
Name field.
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Field Name Definition

Allowed Values:

A valid network name.

This value is completed by your social application.

Default Value:

None.

Refresh Token Definition:

Specifies an refresh token, or code, supplied by
your social application. This token provides long-
term authentication to some social applications. See
the documentation for your social application for
details.

Allowed Values:

A valid token.

This value is completed by your social application.

Default Value:

An unique token.

Version Information Definition:

Specifies the version information for your API. This
field applies only to Chatter applications.

Allowed Values:

Version information for your social network.

This value is completed by your social application.

Default Value:

None.

Renew Rate Definition:

Specifies how frequently to renew your application's
access token.

Allowed Values:

• Disabled

• Every 15 minutes

• Every half an hour

• Every hour

• Every 2 hours

• Every 4 hours

• Every 6 hours
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Field Name Definition

• Every 8 hours

• Every half day

• Once a day at midnight

• Once a day at noon

• Every other day at midnight

• Every Sunday at midnight

Default Value:

Disabled

Encrypted Definition:

Specifies whether to store the access token as
encrypted in the AgilePoint database.

Allowed Values:

• Deselected - The access token is stored as
plain text.

• Selected - The access token is stored as
encrypted data.

Default Value:

Deselected

Save Function:

Saves the token in your global application settings.

Connecting a Social Media Application with AgilePoint
Enterprise Social Integration
For AgilePoint components, such as AgileParts and AgileConnectors, can connect to a social media application.
To connect a social media application, such as Yammer or Chatter, with AgilePoint Enterprise Social Integration,
do the following.

Prerequisites

• AgilePoint BMPS v5.0 R2 or higher.

• An active account with the social media application you want to connect with AgilePoint

• Registering an AgilePoint Application in Yammer

Navigation

1. On the Enterprise Manager Main Page, click Enterprise Social Token Management.

2. On the Enterprise Social Token Management window, click Add or Edit as appropriate.
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Instructions

1. On the Add/Edit OAuth 2.0 Access Token page, complete the following fields as required:

Field Name Value

Application Name Definition:

Specifies a unique name that identifies your
application.

Allowed Values:

An alphanumeric string with no spaces.

Default Value:

None

Application Type Definition:

Specifies the third-party application, such as
Yammer or Chatter.

Allowed Values:

A list of supported enterprise social applications.

Default Value:

Yammer

Access Token Name Definition:

Specifies the unique name for your connection to
the enterprise social application.

Allowed Values:

An alphanumeric string with no spaces.

Default Value:

None

Custom Attributes:

No

Consumer Key Definition:

Specifies the client ID of the app you created or
added in your third-party application service, such
as Yammer.

Allowed Values:

An alphanumeric string.



Enterprise Social Token Management Page 92

AgilePoint BPMS v5.0 R2 SP1 Enterprise Manager Administrator's Guide r5.4.15

Field Name Value

Default Value:

None

Consumer Secret Definition:

Specifies your client secret of the app you created
or added in your third-party application service,
such as Yammer.

Allowed Values:

An alphanumeric string.

Default Value:

None

Authorization URL Definition:

Specifies the standard authorization URL exposed
by the third-party application service to obtain
your authorization code.

Allowed Values:

A valid authorization URL.

Enterprise Manager completes this field
automatically for supported applications. Do not
change the default value.

Default Value:

An required authorization URL for the social
application.

Access Token URL Definition:

Specifies the standard URL exposed by the third
party application service that is used to obtain an
access token.

Allowed Values:

A valid URL.

Enterprise Manager completes this field
automatically for supported applications. Do not
change the default value.

Default Value:

The standard URL to retrieve the access token
from your social application.

2. Click Get Access Token.
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3. Once you have confirmed your account credentials, you are returned to the Add/Edit OAuth 2.0 Access
Token page, and the following fields are populated:

Field Name Value

Authorization Code Definition:

Specifies the authorization code supplied by your
social application.

Allowed Values:

A valid authorization code.

This value is completed by your social application.

Default Value:

An unique authorization code.

Access Token Definition:

Specifies an access token, or code, supplied by
your social application.

Allowed Values:

A valid token.

This value is completed by your social application.

Default Value:

An unique token.

Instance Name Definition:

Specifies URL of the SalesForce account to which
the current token connects. This is the Misc field
AgilePoint displays to identify the environment this
token is accessing.

This field applies to Chatter only. For Yammer
applications, the Misc field refers to the Network
Name field.

Allowed Values:

A valid network name.

This value is completed by your social application.

Default Value:

None.

4. Click Save.

More Information

• Yammer

http://documentation.agilepoint.com/SupportPortal/DOCS/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html#envYammer.html
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• Chatter

• Enterprise Social AgileConnector

• Creating a Notification Message

Registering an AgilePoint Application in Yammer
To register your AgilePoint application in your Yammer network, do the following.

Prerequisites

• You must be an administrator of your Yammer network.

Navigation

1. Log on to Yammer using a Yammer administrator account.

Instructions

1. On the Yammer home page, under Networks, click the network you want to use with AgilePoint.

2. Click the Ellipses button in the top right corner, and click Created Apps.

3. In the left pane, click Register New App.

4. On the Register New App window, complete the fields as required. Note that the Application Name is
used in AgilePoint to identify this application.

5. Click Continue

6. Copy the Client ID and Client secret. You will need to enter these on the Add/Edit OAuth 2.0 Access
Token page in AgilePoint Enterprise Manager.

7. In the left pane, under My Apps, click Basic Info.

8. In the Redirect URI field, enter your Enterprise Manager URL as follows:

http://[domain]:[port]/EnterpriseManager/System/GlobalAppSettingsEditForm.aspx

http://documentation.agilepoint.com/SupportPortal/DOCS/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html#envChatter.html
http://documentation.agilepoint.com/SupportPortal/DOCS/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html#serverAgileConnectorEnterpriseSocial.html
http://documentation.agilepoint.com/SupportPortal/DOCS/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html#agileshapeCreateNotificationMessage.html
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Reports Page
This page allows the administrator to manage and configure reports based on AgilePoint related data.

SQL Server Reporting Services
AgilePoint provides special integration features for SQL Server Reporting Services and comes with a set of pre-
configured sample reports built using SQL Server Reporting Services. AgilePoint Enterprise Manager provides
the user interface for building, viewing, and exporting reports. Although SQL Server Reporting Services is most
often used, Crystal Reports, Microsoft Excel, and other reporting technologies can also be used to build your
own reports as needed. The AgilePoint database schema is fully documented and can be used to facilitate
custom reports. AgilePoint server also exposes a wide range of Web services that can be used to query and
retrieve process-related data from AgilePoint Server. This data can be used to generate reports in a variety of
ways using a variety of tools. You can also leverage AgilePoint APIs that will return process and run time statistic
data in the form of XML. The XML data can then be used in a custom reporting tool that takes XML as an input.

The AgilePoint SQL Server Reporting Services Integration is installed as part of the AgilePoint Enterprise
Manager installation. During the installation of Enterprise Manager, the installer will prompt you to install the
AgilePoint SQL Server Reporting Services Integration component, which includes a set of pre-configured sample
reports. To install this component requires that you have a working instance of Microsoft SQL Server Reporting
Services installed. Refer to the AgilePoint Installation Guide for more information on installing the AgilePoint SQL
Reporting Services Integration.

Sample Reports
AgilePoint comes with a number of pre-configured sample reports. Once the AgilePoint SQL Server Reporting
Services Integration and the sample reports are installed, you can access them from the Enterprise Manager
Reports page. The sample reports include:

• Average Process Time by Automatic Activities

• Average Process Time by Automatic Activities - Monthly
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• Average Process Time by Automatic Activities - Quarterly

• Average Process Time by Automatic Activities - Weekly

• Average Process Time by Manual Activities

• Average Process Time by Manual Activities - Monthly

• Average Process Time by Manual Activities - Quarterly

• Average Process Time by Manual Activities - Weekly

• Average Process Time by User Performance

• Average Process Time by User Performance - Monthly

• Average Process Time by User Performance - Quarterly

• Average Process Time by User Performance - Weekly

• Average Process Time by Versions

• Average Process Time by Versions - Monthly

• Average Process Time by Versions - Quarterly

• Average Process Time by Versions - Weekly

• Average Process Time Report - All Process

• Average Process Time Report - Monthly

• Average Process Time Report - Quarterly

• Average Process Time Report - Weekly

The AgilePoint sample reports are deployed to SQL Server Reporting Services during the installation. Open
Microsoft SQL Server > Reporting Services > Report Manager and click the AgilePoint link. The sample
reports are stored here, additional reports can be added as desired.
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The AgilePoint sample reports are accessed from the Enterprise Manager Main Page by clicking the
Configuration link in the Report Management section. The sample reports show on the Reports page. The
Reports page allows you to add, edit, or delete a report.

Note:  A user must be given access rights in Enterprise Manager in order to see the Configuration link
and manage reports. Once the user is given access rights, the Report Management section on the
Enterprise Manager Main Page will be visible.

To add a report to Enterprise Manager:

1. Open SQL Server Reporting Services and click the AgilePoint link.

2. Click Upload File.

3. Browse and select the report file for which you want to add. The report file is added.

4. Open Enterprise Manager and click the Configuration link. The Report Management window appears.
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5. Click Add. The Report Browser window appears. The Report Browser window displays all the reports that
reside on the Report Server. From this window you can select a report from the Report Server to add in
Enterprise Manager.

6. Select the newly added report and in the Label field, type a name for the report.

Checking the Show Shortcut check box will display a shortcut link to the report on the AgilePoint Enterprise
Manager Main Page. A maximum of three (3) report shortcuts can be displayed on the Enterprise Manager
Main Page at a time.

7. Click OK. The report is added. To edit a report in Enterprise Manager:

8. From the Report Management page, click the option button next to the report for which you would like to edit
and click Edit. The Report Browser window appears.

9. Change the Label name and click OK. The report is now renamed to the new name.

To delete a report in Enterprise Manager:

1. From the Report Management page, click the option button next to the report for which you would like to
delete and click Delete. Click OK in the confirmation window. The report is deleted from the list.

To create a report:

1. From the Report Management page, click the Average Process Time by Automatic Activities link. The View
Report page appears. The View Report page requires some configuration parameters.

2. In the Process Definition drop-down list, select ExpenseReport_InfoPath as the Process Template you
want this report to run against.

3. In the Time Format field, select Hour and click View Report to generate the report.

To export a report:

You can export the report into various formats such as HTML, CSV, XML.

1. Click the Select a format drop-down list and select CSV (comma delimited).
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2. Click Export.
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AgilePoint Licensing and Activation
This section provides information about AgilePoint licensing.

License Usage Calculations
This section provides information about license usage.

How is AgilePoint License Usage Calculated?

Summary

This article provides information about how the AgilePoint licensing percentages are calculated. Based on your
AgilePoint license agreement, the following information will help you understand how to retrieve and interpret
your Named User License usage and Process Template License usage.

Prerequisites

• AgilePoint BPMS v5.0 R2 and lower. AgilePoint BPMS v5.0 R2 SP1 and higher support only current user
licenses.

Applies To

• Named User License Usage

• Process Template License Usage

More Information

AgilePoint BPMS displays the Process Template License usage and Named Users License usage percentages
on the Enterprise Manager home page, under the Issue Tracking section.

• Process Template License usage is calculated using the following formula:

[(Total Number of Child Process Templates) / (SubProcess Ration) + (Total Number of Non-Child Process
Templates)] / (Total Number of Licensed Process Templates)

For example, if the total number of Child Process templates is 20, the subprocess ratio is 5, the total number
of Non-Child Process Templates is 10, the total number of Licensed Process Templates is 20, the average
Process Template License usage would be 20/5 + 10 / 20 = .7 or 70%. 

• Named User License usage is calculated using the following formula:

(Total Number of AgilePoint Registered Users) / (Total Number of Named Users in the License Agreement)

For example, if the total number of AgilePoint Registered Users is 35, and the total number of named users
in the license agreement is 70, the Named User License Usage would be 35/70 = .5 or 50%.
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AgilePoint Current User (Floating) License FAQ

What is a Current User (Floating) License?

In the AgilePoint Current User (Floating) License model, only the active AgilePoint BPMS system users are
counted against the number of purchased license seats. The number of active users is defined as the number of
user sessions on the AgilePoint Server at a given time.

A user session lasts from initial login from any application to the time the session times out. (The timeout period
is configurable.) If the user logs in before the current session times out, the session and the timeout period
are renewed. Applications that can initiate a user session include AgilePoint Envision, AgilePoint Enterprise
Manager, SharePoint, customized web applications, or web service calls from Microsoft Internet Explorer.

To What AgilePoint Releases Support the Current User (Floating) License Apply?

The Current User (Floating) License is available for AgilePoint BPMS v5.0 and higher.

How can I estimate my number of users for an AgilePoint Current User (Floating)
License?

Use the following calculation to estimate the number of users you will require under the AgilePoint Current User
(Floating) License. Note that this is a basic estimate to be used as a general guideline intended as a starting
point. You can use your own estimating scheme if desired.

[total number of AgilePoint users] * [average number of hours per day each user will be actively using
AgilePoint] / [number of hours per work day] = [number of required floating license seats]

Example: 200 total AgilePoint users * 2 hours average usage per user per day / 8 hours per work day = 50
floating user license seats

Can I Reserve License Seats for Specific Users?

In AgilePoint BPMS v5.0 R2 SP1 and higher you can reserve license seats for specific users. When a license
is reserved, the user's license seat is removed from the pool of floating licenses, and the license never expires.
This is typically used for frequent or high value AgilePoint users who need system access.

How is the AgilePoint Current User (Floating) License Model Different from a
Traditional Session Connection License Model?

AgilePoint Current User (Floating) License Model Different from a Traditional Session Connection License Model
in the following ways.

Characteristic Traditional Session
Connection License

Current (Floating) User
License

Comments

Uses a dedicated TCP/IP
allocation

Yes, such as a database
connection

No This is important for
scalability.

Requires system resource
(e.g., memory) allocation
to maintain session state
at server side

Yes, through database
connection or ASP.NET.

No This is important for
performance and memory
allocation.
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Characteristic Traditional Session
Connection License

Current (Floating) User
License

Comments

Counts the same user
on multiple connections
on different machine as
multiple sessions

Yes No Example: A project
manager are accesses
AgilePoint on her laptop,
and then goes to a
meeting using her mobile
device for a presentation.
The same user session is
used, as long as she logs
on using the same user
account.

Supports partial named
user and partial floating
user

No Yes Example: A company
buys 10 floating licenses,
but the CEO and CIO
may want dedicated
licenses so they can
access system 24/7. The
rest of the users share the
remaining 8 licenses as
floating.

What happens if my total number of concurrent users exceeds my maximum number of
active user license seats?

If your total number of concurrent users exceeds the maximum number of active users allowed by your License
Agreement, the AgilePoint Server will generate an email warning to the system administrator. At this point,
system performance may slow somewhat.

If you receive a warning regarding your maximum users, AgilePoint recommends that you 1) monitor your
license usage, 2) try tuning your session timeout settings to accommodate your current user load, and 3)
purchase additional license seats if required.

How can I monitor my actual number of active users once the system is up and
running?

To monitor your actual number of users, query the AgilePoint database to analyze your maximum number of
users in a day, and the frequency with which that maximum is reached. The AgilePoint system refreshes the
user session count every 10 minutes. A record is generated each time the maximum number of license seats is
reached.

To monitor your license usage, run the following query against the AgilePoint Database:

select DATE_OCCURRED, OBJECT_INFO, DESCRIPTION as WARNING from WF_AUDIT_TRAILS where
CATEGORY=7 order by DATE_OCCURRED desc

The results look like the following. L=n  represents the maximum number of floating license seats. A=n 
represents the number of active user sessions.

DATE_OCCURRED

OBJECT_INFO

WARNING

2010-05-10 17:34:40.027
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L=2,A=3

The maximum number of concurrent users allowed by your AgilePoint License Agreement is 2, but your actual n
….

2010-05-10 17:29:04.400

L=2,A=2

NULL

In addition, you can run the query in Microsoft Excel to create graphs that will enable you to track your usage
over time. For Excel, create the following view:

CREATE VIEW WFV_FLOATING_SESSIONS as select DATE_OCCURRED as [TIME],CONVERT(INT,
RIGHT(OBJECT_INFO, LEN(OBJECT_INFO) - CHARINDEX('A=',OBJECT_INFO) - 1)) as
ACTIVATED_SESSIONS, DESCRIPTION as WARNING from WF_AUDIT_TRAILS where CATEGORY=7

Then create the following query:

select * from WFV_FLOATING_SESSIONS

TIME

ACTIVATED_SESSIONS

WARNING

2010-05-10 17:34:40.027

3

The maximum number of concurrent users allowed by your AgilePoint License Agreement is 2, but your actual n
….

2010-05-10 17:29:04.400

2

NULL

How can I tune my server settings to better accommodate my current number of user
licenses?

If your number of concurrent, active user sessions are exceeding the number of seats in your Current User
(Floating) License Agreement, you can change the session timeout interval to better accommodate your usage.

There is a tradeoff between greater numbers of available license seats and system performance. If you have
shorter session timeouts, you tend to have a higher number of available license seats, but frequent user session
renewals can negatively impact system performance. On the other hand, if you have a longer user session
timeout period, performance is better because the system is not renewing user sessions as often. However,
longer timeouts can yield fewer available license seats and active sessions for users who are not actively using
the AgilePoint system.

To modify the session timeout, in the AgilePoint neflow.cfg file in the <server>  node, modify the value of the
UALExpirationPeriod attribute (<server UALExpirationPeriod="n" ...>). The unit for this value is minutes. The
minimum value is 15.

How can I purchase additional license seats?

To increase your Current User (Floating) License capacity, contact AgilePoint Sales.
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Subscription-Based Licensing
Subscription-based licensing is available fir AgilePoint BPMS. Using subscription-based licensing, you can pay a
periodic fee for the AgilePoint service, rather than buying an indefinite license for all users.

For more information, contact  AgilePoint Sales.

Finding and Obtaining License Keys
This section provides instructions for finding and obtaining AgilePoint license keys.

Finding the License Key for an Installed AgilePoint Component

Objective

To provide instructions for finding the License Key that is associated with an installed AgilePoint component.

Summary

The License Key for a particular installed AgilePoint component (Envision, Server, Developer) can be found by
either using the utility attached below or by navigating the registry.

Prerequisites

• AgilePoint BPMS v5.0 R2 or lower

Resolution

Solution 1:

The easiest way to find the license key associated with a particular installed AgilePoint component is to
download and run the ShowlicenseKey.exe utility. This utility can be downloaded as an attachment below.

Solution 2:

An alternative solution to finding the license key associated with a particular installed AgilePoint component is
via the registry as is detailed below.

1. Click Start > Run.

2. In the Open field, type regedit.

3. Click OK.

4. Navigate to the following location:

My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion
\Installer\UserData\

5. Right click on the UserData folder and click Find.

6. Type www.ascentn.com and click Find Next.

7. Press the F3 key until you see "AgilePoint Server" in the Display Name field. The Product ID field shows the
License Key information as shown below:
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8. Continue pressing the F3 key until you find the AgilePoint Developer and AgilePoint Envision components,
each of which displays a Product ID field. This is the License Key used for the installation.

Downloads

ShowLicenseKey.zip.

Obtaining AgilePoint License Keys
Some AgilePoint BPMS components require a license key. When you sign up for an AgilePoint BPMS account
or purchase AgilePoint software, AgilePoint will send you the license keys for the components you need. If
during installation you find you do not have a license key you need, do the following.

Instructions

To obtain new license keys, contact AgilePoint Customer Support.

When requesting new license keys, please provide the following information:

• Your name.

• The name of your company or organization.

• The version numbers and the names of the AgilePoint products that you are planning to install.

• The type (e.g. Evaluation, Development, Production, or Clustered) of license keys and the quantity for each
of the AgilePoint products that you are planning to install.

• If you are requesting a license key as a replacement for a previously issued license key, please provide the
original license key as well.

Please allow at least one full business day for license keys to be provided following your request.

../../../downloads/ShowLicenseKey.zip
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Replacing Temporary License Keys with Production License
Keys

Applies To

Summary

Can I force my evaluation key to expire early?

Can I extend my evaluation key before it expires?

I have an important demo coming up and I am worried that my evaluation key may expire around the demo time.
Is there a way I can reactivate or extend the evaluation key prior to its expiration?

I have purchased permanent keys, how can I replace my evaluation keys with the permanent keys?

Yes. You will need to create a ticket on the AgilePoint Support portal and request the
AgilePointReactivation.zip package. After you have received the package, you can use the instructions below
to force your evaluation keys to expire early and replace your evaluation keys with permanent keys. Then you
will be able to re-activate the product(s) using your new keys.

Prerequisites

• AgilePoint BPMS v5.0 R2 or lower

• AgilePoint Envision

• AgilePoint Developer

• AgilePoint Server

Details

If you want to reactivate AgilePoint Server, simply copy the new AgilePoint Server.dat file to the C:/Program
Files/Common Files/Ascentn folder and replace the existing file. Next time you bring up the AgilePoint Server
Configuration (via Start > All Programs > Ascentn > AgilePoint Server Configuration), it will prompt you to
enter the new license key. Follow the same procedure for AgilePoint Envision and AgilePoint Developer. For
more information on activating a particular AgilePoint component, see the related articles below.

Keep these .dat files handy as you may want to use them again later.

NOTE: You will need to request new license keys to extend your evaluation.

Note:  Each copy of the AgilePoint SAP Integration installation software is unique, and a unique license
key is created for each installation package. If you installed an evaluation copy of AgilePoint SAP
Integration during your AgilePoint trial, you must uninstall the evaluation copy and reinstall the software
using the official production installation software. The the production license key will not work with an
evaluation software installation. For more information, contact  AgilePoint Support.

Activating AgilePoint Licenses
This section provides instructions for activating the licensed components of the AgilePoint BPMS Suite:

• AgilePoint Envision
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• AgilePoint Developer

• AgilePoint Server

Activating Over the Internet
Internet activation is recommended for all machines with Internet connections.

Prerequisites

• An Internet connection

• Administrator privileges

• You are running a licensed product that meets one of the following conditions:

• It is the first time you've run the product after installation

• It is the first time you've run the product after an evaluation license key expired

Navigation

1. Open the application you want to activate. The Activation Wizard appears.

Instructions

1. On the Activation Wizard, select Activate by using Internet.

2. Click Next.

Your product should be activated automatically within a few seconds.

Activating Manually
Use manual installation if you are unable to activate over the Internet.

Prerequisites

• Administrator privileges

• You are running a licensed product that meets one of the following conditions:

• It is the first time you've run the product after installation

• It is the first time you've run the product after an evaluation license key expired

Navigation

1. Open the application you want to activate. The Activation Wizard appears.

Instructions

1. On the Activation Wizard, select Activate manually.

2. Click Next.

3. On the Product ID window, click the Activation Key link.
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4. On the web page that appears, copy the URL, and paste it into a web browser on a machine where an
Internet connection can be established. The AgilePoint Activation page appears with the Product ID
displayed.

You can also access the AgilePoint Activation page via the following URL: http://act.agilepoint.com/
ActivationServer/ActivationKey.aspx . If you choose this method, you must also type the Product ID.

5. Click Submit. The Activation Key appears.

If this process fails to generate an Activation Key, email the following information to AgilePoint Customer
Support:

• Your name.

• The name of your company or organization.

• Appropriate contact information.

• The Product ID specified by the Activation Wizard.

AgilePoint will reply with the required Activation Key.

6. In the Activation Wizard window in the Activation Key field, copy and paste the Activation Key.

7. Click Next, and then click Finish.

http://act.agilepoint.com/ActivationServer/ActivationKey.aspx
http://act.agilepoint.com/ActivationServer/ActivationKey.aspx
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Pages
This section provides a list of pages in Enterprise Manager.

Main Page
This page acts as a portal that allows the administrator to navigate to the various pages of the AgilePoint
Enterprise Manager Web application.

Login Page
This page allows the administrator to login to the AgilePoint Enterprise Manager Web application.
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Tasks Page
This page allows the administrator to review, search for, and update (e.g. reassign or cancel) the individual
workflow tasks managed by AgilePoint Server.

Here is an example of the Tasks page as displayed when using the My Tasks link from the main page.

Find Tasks Dialog
This dialog allows the administrator to search for workflow tasks by specific criteria.
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Processes Page
To access the Processes page, click the Processes link on the Enterprise Manager Main Menu. The Processes
page allows the administrator to first find a process instance for which to perform an action. Once the process
is found, actions such as suspend/resume, rollback, cancel, and migrate can be performed on the process
instance.
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Process Page
The process page provides detailed information about the process instance such as the activities, manual tasks,
event log, process monitor, and data elements as shown below. At this layer, the option to migrate the process
instance to a new process instance is available.

Data Tracking
The DataTracking tab allows the administrator to view for a specific field on a form, the "Old Value" and if the
data changes, the "New Value". The following information is available:

• Name of the form field

• Old value before the data was changed
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• New value of the data

• The user that changed the data

• The time stamp when the data changed

Email Template Window
This section provides information and instructions about how to use the fields in the Email Template. The fields
in the Email Template are used to specify what the participant(s) will see when the Email Notification is opened.



Pages 114

AgilePoint BPMS v5.0 R2 SP1 Enterprise Manager Administrator's Guide r5.4.15

In addition to manually typing in the value of a field, most of the fields in the Email Template allow you to also
select from a list of process attributes to dynamically populate that field at run time. To bring up the list of
available process attributes, type ${ in the text box and select the process attribute for which you would like to
use in that field. For example, you may want to select ${TaskParticipantUserName} in the To field of your Email
Template. The To field will be populated with the user name of the task's participant.  

Incoming and Reminder Emails are sent separately for each participant, while Activity Exit Emails are sent per
activity (regardless of number of participants). Therefore, if your email address is in the To or CC field of the
email template associated with the Activity Entry Email, you will get X number of copies of the email. If the entire
list of (potential) participants is in the To or CC field, then all of the (potential) participants will receive X number
of copies of the email. If you use the ${TaskParticipantUserName} process attribute in the To field instead of
specifying the entire list of participants in the To field, then for each participant, a separate email will be sent,
and none of the participants will receive duplicate copies of the email.

If you want to send a single email to all of the (potential) participants (instead of separate messages), you could
use the Email AgileShape to send a single email, instead of associating your template with the Activity Entry
Email property of a multi-participant manual activity.
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Field Definitions

Field Name Definition

Name The Name field is used to display the name of an
Email Template. The name specified should be
meaningful to the process modeler.

From The From field is used to specify what gets displayed
in the From field of the Email Notification. This field
supports the use of pre-defined process attributes.
When a pre-defined process attribute is used, the
"domain\username" will be converted automatically.

To The To field is used to specify what gets displayed
in the To field of the Email Notification. This field
supports the use of pre-defined process attributes.
When a pre-defined process attribute is used, the
"domain\username" will be converted automatically.
You can add multiple entries by separating them with
a semicolon.

CC The CC field is used to specify what gets displayed
in the CC field of the Email Notification. This field
supports the use of pre-defined process attributes.
When a pre-defined process attribute is used, the
"domain\username" will be converted automatically.
You can add multiple entries by separating them with
a semicolon.

Subject The Subject field is used to specify what gets
displayed in the Subject field of the Email Notification.
This field supports the use of pre-defined process
attributes.

Priority The Priority field is used to specify the priority setting
of the Email Notification. Valid values for this field
include: Normal, High, and Low.

Format The Format field is used to specify the format for
which the content of the email will be displayed.
Both HTML and plain text are supported formats for
email. HTML is set as the default as part of the SMTP
settings during the Server Configuration process. To
send email in plain text format, select Text from the
drop-down list. 

Note:  If you have chosen HTML as the format
of the email, <br> tags are required for line
breaks.
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Field Name Definition

Left to Right/Right to Left The Left to Right and Right to Left option buttons allow
you to change the alignment for which text is inserted
into the content section of the Email Template.

Content The Content field is used to type the custom message
to be displayed in the body of the Email Notification.
This field supports the use of pre-defined process
attributes.

In order to show a URL link as a clickable HTML link
in the email notification, the URL link must be entered
into the email template with the HTML tags. The
following is an example of how to include an URL link
with HTML tags:

<a href="http://machinename:portnum/
applicationname/ApproveRequest.aspx?${TaskID}">
Please click this link to invoke the Request Form.</a>
<br></br>

Note:  If you have chosen HTML as the format
of the email, <br> tags are required for line
breaks.

Attachments The Attachments field is used to specify any files that
you would like to include in the Email Notification. To
attach a file to the notification, type in the full path
of the file e.g., C:\My Documents\sample.doc. You
can also use a custom attribute to attach a file to the
notification e.g., ${AttachDoc} or ${HomeDirectory}\...

Note:  The file that you would like to attach
must reside on the local machine.

Notifications page
This page allows the administrator to review, search for, and update (e.g. cancel or resend) the individual email
notifications managed by AgilePoint Server.
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Find Notifications Dialog
This dialog allows the administrator to search for email notifications by specific criteria.

Performance Page
The Performance Page displays data about the runtime performance of AgilePoint Server and the AgilePoint
Workflow Engine.
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Instructions

1. On the Enterprise Manager Main Page, click Performance.

Configuration Page
This page displays the current values of some of the key configuration settings for AgilePoint Server. It does not
allow you to change any of these settings. Use the AgilePoint Server Configuration utility to modify the settings.

Global E-mail Templates Page
This page allows the administrator to add, update, and delete e-mail templates that AgilePoint Envision users
can apply to create emails.  You can use email templates to apply default values to an email, such as To, From,
CC, BCC, subject, and body. Business users can apply the email templates in AgilePoint Envision.
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Reports Page
This page allows the administrator to manage and configure reports based on AgilePoint related data.

Groups Page
This page allows the administrator to view and update the groups that AgilePoint Server users can belong to.
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Add/Edit Group Dialog
This dialog allows the administrator to add or edit a group.

The "Group Lead" is intended to specify the manager or head of the organizational unit that the group
represents. Although this field doesn't really have any significant effect on the default behavior of AgilePoint at
this time, it can be useful in certain situations.

For example, you could have a custom AgileShape that sends an email notification to the Group Lead of any
Groups that the participant(s) of an activity belong to when a certain event occurs (such as escalation of overdue
activities).

You could also use custom code to query the workflow database and build an organizational chart based on the
relationship between group members, groups, and group leads.
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Add Group From Active Directory Dialog
This dialog allows the administrator to add groups from an Active Directory data source. For group names,
alphanumeric characters and special characters, or a combination of both are supported. The special characters
that are supported include the dash (-) and underscore (_).

Requirements:

• The AgilePoint System User (as defined in the AgilePoint Server Configuration utility) should belong to the
Active Directory domain.

• AgilePoint Server's Application Pool's Identity user account (as configured in IIS) needs to have read
permissions to the Active Directory server and data.

After the search the following dialog appears:
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You can now select a group from the list to add. Select a Group Lead for the group. You can also select one of
the three options when adding new members from AD:

• Do not add member – The group will be created with the group lead as the only member

• Add AgilePoint user only – Only members in the AD group that have already been registered as an
AgilePoint user will be added to the newly created AgilePoint group.

• Add all and register user if necessary – All of the members in the selected AD group will be added to the
AgilePoint group. Any member in the AD group that has not been registered as an AgilePoint user will
automatically be registered as an AgilePoint user.

Note:  When adding groups from Active Directory, if a member has incomplete user account information
in AD, such as a missing email address or the user's full name is blank, AgilePoint will skip the user and
the user will not be registered or added to the AgilePoint group.

Note:  Group names can include up to 64 characters.

Importing Nested Active Directory Groups
This feature supports the adding of a nested group from Active Directory to AgilePoint with the following
behavior:

AgilePoint will not duplicate the entire Active Directory group structure when importing nested groups. Instead,
all members of the top level group in Active Directory, as well as members in its sub-groups, will be added to a
single group (same name as the top level Active Directory group) in AgilePoint. 

Synchronize Group Members dialog
This dialog allows the administrator to update the AgilePoint users' group memberships based on an Active
Directory data source. Synchronizing members for a group will also enable the synchronization of members in
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the sub-groups in Active Directory. During synchronization, all of the members in each sub-group of an Active
Directory group will be combined and added to a single AgilePoint group.

Select the group in the All Groups page of Enterprise Manager and click Synchronize Members. The Domain
Information window appears.

Requirements:

• The AgilePoint System User (as defined in the AgilePoint Server Configuration utility) should belong to the
Active Directory domain.

• AgilePoint Server's Application Pool's Identity user account (as configured in IIS) needs to have read
permissions to the Active Directory server and data.

The members that are available for synchronization will have the Add or Remove link, which allows the member
to be added or removed from an AgilePoint group.

Click Apply All. Clicking on the Apply All link will synchronize all the members that are available for
synchronization.

Delegations Page
The Delegations page allows the administrator to view and manage delegation rules. Delegation is the
temporary reassignment of tasks to another user — usually a peer or subordinate. Delegation can be used, for
example, to temporarily reassign a task when a user is out of the office.

To view the Delegations page, click the Delegations link on the Enterprise Manager Main Page. The list of
delegations is shown.
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Add/Modify Delegation Dialog
The Delegation dialog allows the administrator to add or modify a delegation.

To add or modify a delegation:

1. Click the Add or Modify button on the Enterprise Manager Main Page. The Delegation dialog appears.

2. Select the Originally Assigned and Delegated To users from the drop-down lists provided.

3. Enter the From and To dates for which the delegation will take effect.

4. (Optional) Enter a description that provides information about why the delegation has taken place.

5. Select the Full Range option button to enable the delegation for all dates, or the Specific Dates option button
and select the dates for which the delegation will take effect.

6. Click the OK button. The delegation is now modified or added to the list.
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Activate/De-Activate a Delegation

Note:  You must activate a delegation in order for it to take effect.

To activate a delegation, select the delegation from the list and click the Activate button. The delegation status is
changed to Active. The delegation will now take affect based on the rules you defined.

To deactivate a delegation, select the delegation from the list and click the Cancel button. The delegation status
is now changed to Canceled.

Dynamic Task Instantiation and Insertion Page
The Dynamic Task Instantiation and Insertion page allows the user to add additional participants to an active
Process Adaptation AgileWork.

To view the Dynamic Task Instantiation and Insertion page, click the Dynamic Task Instantiation & Insertion
link on the Enterprise Manager Main Page. The Dynamic Task Instantiation and Insertion page appears.

Note:  A user must have Create a Task and Cancel a Task access rights in AgilePoint Enterprise
Manager in order to see the Process Adaptation functionality in AgilePoint Enterprise Manager.

All the fields and buttons will be enabled if the Process Adaptation manual activity is active.

To add a participant to perform the task:

1. In the Process Template field, select the process template for which to add a participant to complete a
task. The Running Process Instances, Active Manual Activities, and Active Work Items/Tasks for the
process appear. 

2. Select either Parallel or Sequential. Sequential means that the task will be delivered in a sequential fashion
to 1 participant at a time. Parallel means that all the tasks will be delivered to each of the participants at the
same time, there is no particular order for which the task is assigned to the participants.

3. In the Work to Perform field, select the Work to Perform for which to add a participant.
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4. The Users fields provide two list boxes, on the left shows all the users, the right shows the active
participants of the Process Adaptation AgileWork. Select the user and click on >> to move to active users
list and click Confirm. Based on the Approval Type (Parallel or Sequential) it creates a work items for those
users.

Note:  If the Approval Type is sequential, it creates work items sequentially based on the sequence
order in the list. You can change the order by using the Up and Down buttons.
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